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CUF Invoicing (Electronic RR)  
                 User Guide 

 
The CUF Invoicing portal was developed to provide claimants of the Underground Storage Tank Cleanup 
Fund with an online method of submitting Reimbursement Requests.  Below are detailed instructions on 
how to prepare, and submit Reimbursement Requests electronically. Please note that all information 
requested for use in electronic submittals is currently required by existing laws. 

 
Electronic Invoicing Spreadsheet – Invoice Line Item Data Entry 
 
The Electronic Invoicing Spreadsheet is created by claimants using the information contained in each 
invoice for which reimbursement is being requested. Each line item contained on each invoice is entered 
into the Electronic Invoicing Spreadsheet as data into the fields (columns) as specified in the template. All 
invoice line item information contained on the Electronic Invoicing Spreadsheet must be for costs incurred 
during a single fiscal year (July 1 through June 30), single UST Cleanup Fund claim number, and single case 
number (Global ID).  
 
1) Locate the Electronic Invoicing Spreadsheet Template on the State Water Board’s website at: 

http://www.waterboards.ca.gov/water_issues/programs/ustcf/gto/docs/electronic_invoicing_spreadsheet_template.xls 
 
 
2)  Once the Electronic Invoicing Spreadsheet Template opens, select the “Example” Tab. On the “Example” 
Tab, there will be example invoice line item data included to indicate how invoice line items should appear 
once the information is entered. It may be beneficial to print this for future reference.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3)   From the “Example” Tab, select all the rows of example invoice line item data and delete the 

information. Be sure to keep the header row. 
 

4) Begin entering the invoice line items of each invoice as data for each field (column) listed on the 
Electronic Invoicing Spreadsheet “Example” Tab. A brief description of each field (column) and their 
valid values can be found in Tables 1, 2, and 3 located in the Appendix. Some things to remember: 

 

• The Electronic Invoicing Spreadsheet must include invoice line items for costs associated with 
a single UST Cleanup Fund claim. 

• The Electronic Invoicing Spreadsheet must include invoice line items for costs associated with 
the same case (Global ID). 

• The Electronic Invoicing Spreadsheet must include invoice line items for costs incurred during 
a single fiscal year. The only exception to this requirement is if the electronic RR will result in 

http://www.waterboards.ca.gov/water_issues/programs/ustcf/gto/docs/electronic_invoicing_spreadsheet_template.xls
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being the first RR package submitted against the UST Cleanup Fund claim or if the UST Cleanup 
Fund claim is a Priority D.  

• Leave Start Time and End Time fields (columns) blank for all Electronic Invoicing Spreadsheet 
invoice line items. 

• The Requested Amount cannot exceed the Invoice Amount for all Electronic Invoicing 
Spreadsheet invoice line items. 

• The Electronic Invoicing Spreadsheet has all the functionality of an MS Excel worksheet.  
Formulas, copy/paste, etc., can be used to avoid calculation or typographical errors. 

• Do not remove any columns from the Electronic Invoicing Spreadsheet. 
• Invoices dated prior to January 1, 2012 where the Name, Cost Incurred Date, and/or Category 

ID are unknown can be submitted using specific information in the Electronic Invoicing 
Spreadsheet fields (columns).  Refer to Table 1 in the Appendix for instructions. 
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Reporting Mark-up:  
 
The UST Cleanup Fund understands that some costs may have a mark-up applied. In these situations, 
claimants must report the mark-up in a specific way. The following instructions indicate how to enter 
costs with mark-up, if needed. (NOTE: Mark-up can only be applied to costs indicated as third-party in the 
Category field (column). Third-party costs are known as a subcontractor cost).  

 
5)  Subcontractor costs  may be eligible for mark-up at a rate of 10 percent or less. However, the tax 

portion of the invoice is not eligible for mark-up. Therefore, reporting mark-up on the Electronic 
Invoicing Spreadsheet requires a total of three line item entries: 

• A line entry for the subtotal of the original invoice (the original invoice must have a “TP” 
category), 

• A line entry for the tax portion of the invoice, and 
• A line entry for the amount of the mark-up. 

 
In addition to above, the Cost Incurred Date, Invoice Date, Category ID, and Invoice Number fields 
(columns) of the mark-up lines must match the original invoice line item. 

 
 

1 – Invoice numbers must match for all line items 
 

2 – Invoice Date must match for all line items 
 

3 – Mark-up can only be applied to invoices of category “TP” 
 

4 – Cost Incurred Date must match 
 
 
 
 
 
 
 
 
 
 
 
 

5 – Maximum markup is 10 percent (0.1 x Invoice Subtotal Amount) 
 

6 – CategoryID must match for all line items 
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There may be cases where a claimant may need to report mark-up on multiple third-party invoices with 
the same invoice date. Since the Category ID field (column) for these invoices is based on the date of the 
third-party invoice, errors will be generated if you use the date alone in the Category ID field (column). 
 
To avoid these errors, the Category ID can be created using the date followed by a space and another 
numerical value. For example, if you have multiple invoices dated July 31, 2014, the Category IDs will be 
0731014 1, 07312014 2, etc. See below for an example of how the entered invoice line item data should 
appear. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Note: If the Category ID is a date, the checker requires the format mmddyyyy. MS Excel may drop the 
leading zero from your date causing an error unless the Category ID field (column Q) is formatted properly. 
To format the field’s column, first highlight the column, then 
right-click and choose “Format Cells”. Under the “Number” tab, 
select “Text”. This will display the column as text, and preserve 
the leading zero in the date. Once the formatting change has 
occurred, the claimant may need to re-enter the invoice line item 
data field.  
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Electronic Invoicing Spreadsheet – Converting from MS Excel to a Text File: 
 
In this step, claimants will learn how to convert the completed Electronic Invoicing Spreadsheet from an 
MS Excel format to a Text file format, which is the readable format for the GeoTracker CUF Invoicing 
portal. The Text file, also known as CUF Invoice File, will be checked for errors first and then uploaded as 
part of the final electronic RR package. This is a required step and cannot be skipped.   
 
 
6)   After all the data for the invoice line items have been entered, convert the MS Excel file to a 
Text file by saving the file in the Text file format.  

 
a) From the claimant’s opened Electronic Invoicing Spreadsheet, go to the File menu 
option in MS Excel and select “Save As”.  
 

b) The “Save As” dialog box will open. Select a location to save the claimant’s new Text 
File, name the new Text File, and change the “Save as type” option to Text (Tab 
delimited)(*.txt) from the drop-down menu.  
 
c) Once the above is completed, select “Save” at the bottom of the dialog box to 
successfully convert the Electronic Invoicing Spreadsheet from MS Excel file format to 
the Text file format. (Note: Remember where the Text file is saved because the  file is 
needed in future steps.) 
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GeoTracker CUF Invoicing Portal - Checking CUF Invoice File for Errors 
 
Once the Electronic Invoicing Spreadsheet has been converted from MS Excel and saved as the CUF 
Invoice File Text file, the claimant is ready to check the file for data errors. The claimant will upload 
the CUF Invoice File into the GeoTracker CUF Invoicing portal where the system will perform data 
checks and return the results of the data check to the claimant. If errors are found in the claimant’s 
CUF Invoice File, the errors must be resolved prior to proceeding with the upload of the final 
electronic RR package.  

 
7) Click on or copy and paste the following web address into your web browser to access the GeoTracker 
CUF Invoicing portal.  
 
https://geotracker.waterboards.ca.gov/esi/ 
 
 
8) Enter your GeoTracker Username and 
Password at the login screen. This is the same 
information you would use to upload 
information to a case (Global ID) you are 
associated with. If you do not have an account 
with GeoTracker, you must request one before 
being able to upload.  
 

 
 
 
 
 
9)  Once successful login occurs, under the “Tools” menu located on the 
left side of the screen, select the Check EDD option to expand the list, 
and then select CUF Invoice. 
 
 
 
10) After selecting the CUF Invoice option, the first Checking a CUF_Invoice 
File screen will open and display all cases where you have authorization to 
upload information. If you have access to multiple cases, you can search for 
the specific case by searching by the Global ID, street address, or facility 

name. Once the case is found, select the case by clicking the site name under the “Facility Name” column. 
(NOTE: If you are not the Responsible Party for the case, you will need to be granted permission by the 
Responsible Party prior to performing the check. See the link below for more information.) 

http://www.waterboards.ca.gov/ust/electronic_submittal/docs/beginnerguide2.pdf

https://geotracker.waterboards.ca.gov/esi/
http://www.waterboards.ca.gov/ust/electronic_submittal/docs/beginnerguide2.pdf
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11) On the next screen, enter or verify the consultant and claimant information. If the consultant or 
claimant information is incorrect, update the information before proceeding.  (NOTE: Only Fund-eligible 
claim numbers associated with the case (Global ID) will display in the drop-down list. If the UST Cleanup 
Fund claim number being referenced is not listed in the drop-down list, contact the UST Cleanup Fund by 
email to: ustcleanupfund@waterboards.ca.gov.)  Note: After claimant information data has been entered 
for the first time, selecting a claim number from the drop-down list will automatically populate the 
claimant information fields. 
 
12) After the consultant and claimant information is correct, attach the CUF Invoice File to the information 
by selecting “Browse” and navigating to the location where the CUF Invoice File was saved. This is the same 
file that was saved in Step 6.  
 
 

 
 
13)  Once the information and file are attached, select “Check File(s)” to run the Checker. The 
Checker will analyze the file submitted and return any warnings or errors, if applicable. 
 

• Warnings – Warnings are used to give the uploader notice that there may be some issues with 
entries on the Electronic Invoicing Spreadsheet. For example, if the system recognizes an 
invoice number that has been used in previous submittals, a warning will appear. An 
electronic RR can still be uploaded with warnings present. 

•  Errors – When there is an error in the Electronic Invoicing Spreadsheet, the upload cannot be 
accepted by the GeoTracker CUF Invoicing portal. For example, if there is a calculation error, 
or if the requested amount is greater than the invoice amount, an error is generated. The 
upload of an electronic RR cannot occur until the error is resolved. 

 
 
 
 
 
 

mailto:ustcleanupfund@waterboards.ca.gov
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If errors are found by the CUF Invoice File Checker, the next screen will display the following message: 
 

 
 
Click on the text “Click Here to View the Errors” to open a new browser tab that displays all the errors 
and warnings associated with the checked CUF Invoice File. 
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Understanding the Error Screen:  
 
The following information will provide instruction on how to read and correct changes found during the 
checking of the CUF Invoice File. Any corrections should be made to the MS Excel Electronic Invoicing 
Spreadsheet file. After corrections are made, Steps 9-16 will need to be performed again.  
 

14) Review the CUF Invoice File errors and/or warnings as displayed by the Checker. The Checker lists 
the errors/warnings with the corresponding row number from the file where the error/warning can be 
found. This information is useful to locate the row that contains the data error/warning on the original 
MS Excel Electronic Invoicing Spreadsheet file. (See example of error screen below) 
 

(Error Screen) 
 
 
 
 
 
 
 
 
 
 
15)  Open the MS Excel Electronic Invoicing Spreadsheet file to review the row in which the error/warning 
occurred against the information returned by the Checker. (See example of spreadsheet below.) 

 
(Original Spreadsheet) 

 
InvoiceDate Phase Category Classification Name CostIncurredDate StartTimed EndTime Unit Rate Quantity InvoiceAmount RequestAmount Description CategoryID 

1/1/2014 1PM SSEG Senior Geologist Art Tatum 7/1/2013   HOUR      115               3                     115                         345 Project Management 2000 
1/1/2014 1PM SPEG Principal Geologist Benny Goodman 

Charlie Parker 
7/1/2013   HOUR 140 2 280 280 CAP Prep, Review & Signature 1956 

1956 1/1/2014 1PM SPAEG Project Geologist 10/16/2013   HOUR 115 1 115 115 USTCF CO Request Preparation 
1/1/2014 3GW EQUIP-OTHER Water Level Probe Water Level Probe 10/16/2013   DAY 25 1 25 25 Water Level Probe 33 
1/1/2014 3GW EQUIP-AUTO Vehicle Use Sarah Vaughan 

 
1/1/2012   MILES 0.555 500 277.5 277.5 Vehicle Use 6HSA267 

 

 
16) To correct errors, make changes to the indicated rows and cells in the MS Excel Invoicing Spreadsheet 
file. When you are finished making changes, you will need to repeat the Checker process again, including 
saving the file as a Text file (see Steps 6-16). (See the below example to illustrate how to read the Checker 
screen against the MS Excel Invoicing Spreadsheet file and how to make changes.) 
 
EXAMPLE: In Row 2 of the example (the header row is counted as row 1), the Invoice Amount does not 
equal Rate x Quantity (115 x 3 is not 115). Because of this miscalculation, the Requested Amount ($345) is 
greater than the Invoice Amount, which creates another error. 
 
An error is generated in Row 4 because the Category ID (which should be a unique number for each 
person), is the same for 2 individuals (Benny Goodman from row 3, and Charlie Parker from Row 4). 
 
The last error is in Row 6, where the Cost Incurred Date is 1/01/2012. Because this date is not in the 
same fiscal year as the other cost incurred dates, an error is generated. 
 
Warnings are also generated in the example. In the first warning the same CategoryID is used for 2 
individuals. The second warning indicates that the rate charged is in excess of the UST Cleanup 
Fund’s Cost Guidelines. (See the UST Cleanup Fund’s website for the most recent version of the Cost 
Guidelines.) 
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17) If the Checker determines that the CUF Invoice File contains no errors, then the checker will return the 
below message. (NOTE: If the Checker determines that there are warnings associated with the CUF Invoice 
File, then the warnings can be accessed by clicking the text “Click here to view these warnings”.)  
 

 
 
 
 
 
 
 
 
 
Click on “View/Print CUF Invoice Form” 
to access the review screen that summarizes the invoice details, gives a list of remaining warnings, and 
displays the invoice line items.  
 
18) PRINT AND SIGN THE CUF INVOICING SUMMARY FORM. The CUF Invoicing Summary form should be 
signed by all parties once the information, invoices, and supporting documents have been reviewed and 
approved by the claimant and uploader. The entire form (including the invoice line items), will be scanned 
and uploaded in Step 20 along with the signed RR form. 
 
19) The Amount Requested and cost incurred fiscal year on the CUF Invoicing Summary form MUST be 
transferred to the RR form prior to signature from the claimant(s). The claimant should not sign the RR form 
until all information, invoices, and supporting 
documents have been reviewed and approved.  
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GeoTracker CUF Invoicing Portal - Uploading Final Electronic RR  
 
After the CUF Invoice File has successfully passed the Checker, the electronic RR can be uploaded through the 
GeoTracker CUF Invoicing Portal. The entire electronic RR will consist of the Signed CUF Invoicing Summary 
File and RR form, CUF Invoice File, and the Supporting Documents file.  
 

 
20) After successfully checking the CUF Invoice File for errors and all signatures 
have been collected on the CUF Invoicing Summary file and the RR form, the 
electronic RR is ready for uploading.  Login to GeoTracker as completed 
previously in Step 7. 
 
21) Once logged in, select from the “Tools” menu located on the left side of the 
screen, select the Upload EDD option to expand the list, and then select CUF 
Invoice. 
 
 
 
 
 
 
 
 
 
 
 
 

 
22) As in Step 10, search for the case (Global ID) associated with the UST Cleanup Fund claim for which the 
electronic RR is being uploaded.  Once the case is located, select it by clicking the site name under the “Facility 
Name” column. 
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23) After the case is selected, the next screen will display a list of previously uploaded ESI items (i.e., 
reports, CUF documents, lab data, etc.). Select all ESI items that support the electronic RR submission by 
checking the box next to the displayed item and clicking “Continue.” By performing this action,  the 
relevant ESI items will be linked to the electronic RR that is currently being uploading. If there are not any 
ESI items that support the electronic RR submission, choose “Continue” without selecting any ESI items.  
(Note: In order to link ESI items to electronic RR submissions, the ESI documents must uploaded prior to 
uploading the electronic RR. For information on uploading ESI items, see link below.)  

http://www.waterboards.ca.gov/ust/electronic_submittal/docs/beginnerguide2.pdf 

 
24) Once the linking of ESI items is complete, the Uploading a CUF_Invoice File screen will display. From 
this screen, enter or verify the Consultant and Claimant Information sections. If the consultant or claimant 
information is incorrect, update the information before proceeding. 

 
25) After the consultant and claimant information is correct, attach the three required files to upload the 
electronic RR by selecting “Browse” and navigating to the location where the files are saved. 
 
26)  Once the information and 
files are attached, select 
“Upload File(s)” to upload the 
electronic RR. The GeoTracker 
CUF Invoicing portal will check 
and analyze the files submitted 
and return any warnings or 
errors, if applicable. 
 
 
 
 

http://www.waterboards.ca.gov/ust/electronic_submittal/docs/beginnerguide2.pdf
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• Signed CUF Invoicing Summary File (Form 
generated by GeoTracker after CUF Invoice passed 
data checker) and RR form – These documents were 
generated and signed in Step 17. First, scan the  
Summary file and the signed RR form into the 
computer and save it as a .pdf file. Next select 
“Browse” (shown below) and navigate 
to the location on your computer where the scanned file 
is stored. Attach the file by clicking “ok”. 
 
• CUF Invoice File (Text file) – This is the text file 
that was created in Step 6 containing each invoice line 
item. Select “Browse” (shown below). Navigate to the 
location where the .txt file is stored and attach it by 
clicking “ok”. 

 
 
•       Supporting Documents – As with the Signed 
CUF Invoicing Summary file, the invoices related to your 
RR package will have to be scanned as a .pdf file. Each primary invoice is represented by a unique invoice 
number in the Text file and must be scanned separately, and named in the format: <invoice#>.pdf. Sub-
invoices for each primary invoice must be scanned and included in the .pdf file in the same order they 
appear in the invoice. For a successful upload, each unique invoice number itemized in the text file must 
have a corresponding .pdf file. Also, any site narratives should be scanned and included as part of the first 
invoice file submitted. 
 
All the .pdf files must be combined into a .zip file for uploading.  See instructions on creating a zip file below. 
For example, in the Spreadsheet file below there are two unique invoice numbers 100167, and 66713. 
Therefore, the .zip file must contain two files: 100167.pdf and 66713.pdf. 
 

   Global_ID  Invoice#   InvoiceDate 
          

 Phase Category 
T10000004571 100167 1/1/2014 1PM SSEG 
T10000004571 66713 7/10/2013 1PM SSEG 
T10000004571 66713 7/10/2013 1PM SSEG 
T10000004571 66713 7/10/2013 3GW EQUIP-OTHER 
T10000004571 66713 7/10/2013 3GW EQUIP-AUTO 
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Creating a .Zip File 
 

27) To create the .zip file for Step 15, right-click an 
open area of the desktop and select: 

 
New >> Compressed (zipped) Folder 

 
 
 
 
 
 

This creates a new .zip folder on the desktop which 
can be renamed if you wish. Any files you drag and 
drop into the folder will become a part of the .zip 
archive, and will be included when you upload the 
.zip folder. 

 
 

A successful upload will generate the screen below. If there are any errors, they will be displayed as in 
Step 14. 
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28) Print a copy of the Success screen and keep with the claimant’s copy of the RR package.  
 
29) Print the Confirmation No. located on the Success screen on the GeoTracker Confirmation No. line of the 
RR form. This information is needed by the UST Cleanup Fund to match up the documents that the claimant 
MUST send in for their reimbursement payment to be processed.  
 
30) Mail the paper copy of the CUF Invoicing Summary and RR forms containing “wet” signatures to the UST 
Cleanup Fund. These documents MUST be received by the UST Cleanup Fund prior to the release of any 
eligible costs for reimbursement payment. If these documents are not received by the UST Cleanup Fund, the 
RR will be suspended.  

 
31) Once the electronic RR has been successfully uploaded, the uploader can view the status of the electronic 
RR submission at any time by selecting one of the options under the “View Submittals” section on the left 
panel of the GeoTracker screen. 

 
•   The Pending Submittals area will display all electronic RR 

submissions that have not yet been accepted or denied for review 
by the UST Cleanup Fund. 

•   The Denied Submittals Area will display all electronic RR 
submissions that have been denied for review by the UST Cleanup 
Fund. 

•   The Received Submittals area will display all electronic RR 
submissions that have been accepted for review by the UST Cleanup 
Fund. 

•   The All Submittals area will list all electronic RR submissions 
to the UST Cleanup Fund. The Status column on the far right 
indicates the current status of the electronic RR submissions 
(Pending, Received or Denied for review by the UST Cleanup Fund). 
(See below example). 

 
 

 
 

 



Page | 16 Revised 03/15/2016 
 

 

APPENDIX 
 
 
 
 

Table 1 - Description of Spreadsheet Fields and Valid Values 
 
 
 

 
 
 

 

Field 
 

Description 
Global_ID The unique identifier for a regulated facility or site. 

 
Invoice# Each invoice should have a unique identification number, and each line item of the invoice should include this 

number. 

InvoiceDate The date that the invoice was generated. 

Phase The phase of cleanup under which the work was performed. (See Valid Value List for appropriate Phase) 
 

Category* 
 

This field is used to categorize the type of cost represented by the line item. (See Table 2 for Valid Values List.) 

 
Classification This field identifies the classification (i.e. job titles used internally, travel/vehicle use, markup, or third-party invoice 

number, etc.) of the line item as defined by the organization submitting the invoice. 

   Name 
Name of the person completing the work or the name of the invoice item (i.e., Travel, or SVE Unit). If the invoice is dated 
prior to January 1, 2012 and the name of the person completing the work is unknown, enter UNKNOWN in this field. 

 
CostIncurredDate 

The date the activity or work was performed. For third-party items, the date should be the first service date or the first 
day of the billing period. If the invoice is dated prior to January 1, 2012, and the exact date is unknown, enter 
1/1/1965 in this field. (NOTE: All CostIncurredDates for a given RR must fall within the same fiscal year. The State 
fiscal year begins July 1st of each year and ends on June 30th of the following year.) 

CostIncurredStartTime This is the starting time for which the task/work commenced. (NOTE: This field must remain blank at this time. This 
field may be enabled at a later time.) 

CostIncurredEndTime This is the ending time for which the task/work completed. (NOTE: This field must remain blank at this time. This 
field may be enabled at a later time.) 

 
Unit The unit of work used when performing the cost calculation, such as hours, etc. Use INVC when inputting total cost of an 

invoice, or RCPT when inputting total cost of a receipt. 

Rate The rate at which a cost is calculated (Rate x Quantity = Invoice Amount). 

Quantity The number of units being calculated. 
 

InvoiceAmount The total amount of the invoice line item, which is the rate multiplied by the Quantity (Rate x Quantity = Invoice 
Amount). (NOTE: The invoice amount must equal Rate x Quantity or an error will occur.) 

 
RequestAmount The amount requested for the invoice line item. (NOTE: This amount may be equal to or less than the invoice 

amount or an error will occur.) 

Description Use this field to enter a brief description of the invoice line item (240 characters or less). 

 
CategoryID 

The unique identifier for the invoice line item (i.e., professional license number, the person’s unique employee 
number, vehicle license plate number, equipment serial number, third-party invoice number, etc.).  If the invoice is 
dated prior to January 1, 2012 and the license number or unique identifier is unknown, create a unique Category 
ID and enter USTCF_UNK + Unique Category ID in this field. 

 
BilledToName 

The name of the person or organization who was billed on the invoice (NOTE: This field must be entered in ALL CAPS 
and must match the name(s) on file with the Fund. If the consultant was billed, enter CONSULTANT. If no name is 
listed, use NOTLISTED). 
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Table 2 – Description of Category Valid Values 
 
 
 
 
 
 
 

Category Code Description 
 

SPEG 
 

Principal Engineer/Geologist 

SPM Project Manager 
 

SSEG 
 

Senior Engineer/Geologist 
 

SPAEG 
 

Project/Associate Engineer/Geologist 
 

STSEG 
 

Staff Engineer/Geologist 
 

SST 
 

Senior Technician 
 

ST 
 

Technician 
 

SDP 
 

Drafts Person 
 

SC 
 

Clerical 
 

EQUIP-OTHER 
 

Equipment used or rented 
 

EQUIP-AUTO 
 

Vehicle used or rented 
 

TP-LAB 
 

Subcontractor or other third-party laboratory invoice 

TP-INVOICE Subcontractor or other third-party invoice (non-lab) 
 

TP-RECIEPT 
 

Subcontractor or other third-party receipt 
 

TP-BILL 
 

Subcontractor or other third-party bill 
 

TP-PERDIEM 
 

Per Diem charges (food and hotel costs) 
 

MARKUP 
 

The markup charged on the sub-total (before taxes) of another line item 
 

OTHER 
 

Work done by other means 

ETAC Costs associated with the preparation of documents for electronic upload 

RTAC Regulatory Technical Assistance Costs 
 

DB-EQUIP-OTHER 
 

Equipment used or rented that is billed directly to the claimant 
 

DB-EQUIP-AUTO 
 

Vehicle used or rented that is billed directly to the claimant 
 

DB-ETAC Costs associated with the preparation of documents for electronic upload that are directly billed to the claimant. 
 

DB-LAB 
 

Laboratory invoice that is billed directly to the claimant 
 

DB-INVOICE 
 

Non-lab invoice that is billed directly to the claimant 
 

DB-RECIEPT 
 

Receipt that is billed directly to the claimant 

DB-BILL Bill that is billed directly to the claimant 
 

DB-OTHER 
 

Work done by other means that is billed directly to the claimant 
 

DB-RTAC 
 

Regulatory Technical Assistance Costs that are billed directly to the claimant 
 

TAX 
The tax associated with a line item.  This must be a third party cost (valid values starting with TP). DB costs may 
include the tax in the total.  DB costs do not need to use this category. 
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Table 3 – Description of Phase Valid Values 
 
 
 
 
 
 

Code Description 
1PM Project Management 
2SA Site Assessment 

3GW Groundwater Monitoring 
4IRA Interim Remedial Action 
5RS Remedy Selection 
6RI Remedial Implementation 

7RSOM Remedial System O&M 
8PRC Post Remediation/Closure 

 


